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Accessing the Frontend Control dialog

1 Welcome to the Frontend Control option

The R&S SMM-K553 option Frontend Control is a firmware application that allows you
to configure and calibrate external frontends connected to the R&S SMM100A.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMM100A user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMM100A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMM100A service manual.

1.1 Key features

The R&S SMM-K553 features:

® Configuring external frontends, including setting the output RF level and RF fre-
quency of the connected external frontend at R&S SMM100A taskbar

® Correcting frequency responses of the external frontend

e Correcting cable losses within the connecting cable between external frontend and
R&S SMM100A

1.2 Accessing the Frontend Control dialog

Accessing the functionality requires that an external frontend is connected to the
R&S SMM100A. You need connections for control of the external frontend (LAN), for
the reference signal and for the IF signal.

How to: Chapter 3, "Operating external frontends", on page 13

To open the dialog with Frontend Control settings

FEaas . » Select one of the following in the block diagram:
o e Click the "FE ..." icon to the right of the "RF" block.
@ For example, the icon displays "FE44S" for an R&S FE44S connected to the
=A R&S SMM100A.

e Select "RF" > "RF Frontend" > "Frontend Device".

A dialog box opens to configure external frontend settings.
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Documentation overview

To output the upconverted IF signal from the R&S SMM100A at the external frontend,
select "RF > On".

1.3 What's new

This manual describes firmware version FW 5.30.305.xx and later of the
R&S®SMM100A.

Compared to the previous version, it provides the new information listed below:
® Editorial changes

1.4 Documentation overview

This section provides an overview of the R&S SMM100A user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smm100a

1.4.1 Getting started manual

Introduces the R&S SMM100A and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.4.2 User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:

® Base unit manual
Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

® Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMM100A is not included.

The contents of the user manuals are available as help in the R&S SMM100A. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the inter-
net.
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Documentation overview

1.4.3 Service manual
Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.4.4 Instrument security procedures

Deals with security issues when working with the R&S SMM100A in secure areas. It is
available for download on the internet.

1.4.5 Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.4.6 Specifications and product brochures

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S SMM100A. It also lists the firmware applications and their
order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smm100a

1.4.7 Calibration certificate

The document is available on https://gloris.rohde-schwarz.com/calcert. You need the
device ID of your instrument, which you can find on a label on the rear panel.

1.4.8 Release notes and open source acknowledgment
The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

www.rohde-schwarz.com/firmware/smm100a
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Notes on screenshots

1.4.9 Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

For some application sheets, see also:

www.rohde-schwarz.com/application/smm100a

1.4.10 Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

O On the menu bar, search for your product to find related videos.

HOME VIDEOS SHORTS PLAYLISTS COMMUNITY CHANNELS ABOUT ':)\ <product=

Figure 1-1: Product search on YouTube

1.5 Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:

® Managing settings and data lists, like saving and loading settings, creating and
accessing data lists, or accessing files in a particular directory.

® |nformation on regular trigger, marker and clock signals and filter settings, if appro-
priate.

® General instrument configuration, such as checking the system configuration, con-
figuring networks and remote operation

® Using the common status registers

For a description of such tasks, see the R&S SMM100A user manual.

1.6 Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.
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Notes on screenshots

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.
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2

2.1

2.2

External frontend basics

About the Frontend Control option

This chapter provides information on required options and basics for controlling exter-
nal frontends.

Required options

The equipment layout for external frontend operation includes:
® Base unit
® Baseband generator (R&S SMM-B9)
® Frequency option:
For external Frontends R&S FE44S and R&S FE50DTR:
— R&S SMM-B1006 or higher
For external Frontends R&S FE170ST and R&S FE110ST:
— R&S SMM-B1020 or higher
® Frontend control option R&S SMM-K553

For more information, refer to the specifications document.

External frontend basics

Due to the physical dimensions of modern signal generators, long RF cables between
the DUT and the signal generator are often necessary in complex test setups. When
measuring high frequency signals, the long RF cable can lead to unwanted loss.

An external frontend with smaller physical dimensions allows for testing closer to the
DUT. The test signal is transferred (TX mode) from the R&S SMM100A to the external
frontend on a lower intermediate frequency (IF). At the external frontend, the IF signal
is upconverted and further transerred to the DUT, for which loss does not have a major
effect.

Thus, the external frontend outsources the conversion of the IF input signal to the RF
output signal required for processing at the DUT. The external frontend upconverts the
low-frequency IF input signal to a higher frequency RF signal using its own internal
local oscillator (LO). For all subsequent signal generation steps in the R&S SMM100A,
this process is transparent.

Outsourcing has two main advantages:

® Extended frequency range:
The external frontend can process RF data in a higher frequency range than the
R&S SMM100A itself supports. For example, using an R&S FE44S external fron-
tend and R&S SMM100A, you can generate RF signals in a range of 24 GHz to
44 GHz.

® Minimized RF cable loss:
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Test setup

Difficult testing environments, long RF cables between the R&S SMM100A and the
DUT are no longer necessary. The external frontend, which is much smaller than
the R&S SMM100A, can be placed closer to the DUT using shorter RF cables. The
required IF cable between the R&S SMM100A and the external frontend is not as
vulnerable to distortion effects and power loss. Furthermore, since the IF cable is
usually part of the fixed setup, any existing frequency response can be calculated
in advance. The R&S SMM100A can then adapt signal generation automatically.

A typical application is a test involving a DUT placed in an RF shield box, see "OTA

microwave test setup” on page 11. The external frontend is connected directly to the
RF shield box, while the R&S SMM100A and R&S FSV/A are placed in a measure-

ment rack elsewhere in the laboratory.

2.3 Test setup

The R&S SMM100A supports the following external frontend types:
® R&S FE44S

R&S FES50DTR

R&S FE170ST

R&S FE110ST

For details, see the specifications document of the R&S SMM100A.

OTA microwave test setup

You can use an external frontend, e.g., for over-the-air (OTA) microwave testing. Fig-
ure 2-1 illustrates an example of a test setup including a vector signal generator, an
external frontend, a DUT inside an RF shield box and a vector signal analyzer.

The signal generator provides the IF signal and the reference signal to the external
frontend. The signal analyzer can also provide the reference signal. All instruments are
connected to the same LAN. The signal generator or signal analyzer control the exter-
nal frontend via LAN using a secure socket layer (SSL) connection, see "Frontend con-
trol connection" on page 12.

The external frontend up-converts the IF signal from the signal generator and transmits
the RF signal to the DUT (TX mode). The DUT receives the RF signal and responds by
transmitting an RF signal to the external frontend. The frontend down-converts the RF
signal to an IF signal and transmits the IF signal to the signal analyzer (RX mode).
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Test setup

[ “Rx mode=—

Vector sianal - IF Out RF shield box

ector sigha

ana|yzerg LAN |—| IFOutA | | RFA J«RF In—] //
[Refout }— 4

R&S DUT

Ref-
FE50DTR
)

IFnB | | RFB |—RFOut—>—Y

| RefOut |
Vector signal -
generator LAN F

1 —" )

=—Tx mode=p

Figure 2-1: Typical setup using an external frontend

Frontend control connection

You can control an external frontend via LAN by one control instrument that exclusively
controls the external frontend. Using an SSL connection, the control instrument sends
commands to the external frontend to perform the following actions:

® To lock the external frontend

® To unlock the external frontend for frontend control by another instrument

® To set the network settings of the external frontend

® To read out the IF frequency

® To set and read out the frequency bands

® To calibrate the external frontend

® To check and update the frontend firmware

® To set the frontend frequency and level

Some test setups require that more than one instrument controls the external frontend
during test execution. The R&S FE50DTR-type external frontend has two channels that

are an Rx and a TX signal path. Both channels use the same internal LO and thus both
signal paths operate on the same frequency.

You can connect up to two instruments to one frontend, e.g a R&S SMM100A and a
spectrum analyzer. If one instrument locks the frontend, the second instrument is still
accessible.

Once two locks of the SSL connection are established, the external frontend is not
accessible by other instruments in the LAN via this path. When an external frontend is
locked, the LAN LED on the front panel is orange.

For details on setting up and operating external frontends, see Chapter 3, "Operating
external frontends", on page 13.
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3

3.1

Connecting external frontends

Operating external frontends

This chapter provides an overview on step-by-step instructions related to connecting
and configuring external frontends.

It includes the following:

o Connecting external froNteNdS..........coiiiiiiiiiii e 13
e Controlling external froNteNAS.......ccuiiieiii e 17
e Generating RF oUtput SIgNAIS........cccuuiiiiiiiiiec e 27
o Updating the firmMWare..........ccooiiiiii it e e e e e e e e e e e e eeeaneaees 29

Connecting external frontends

This chapter provides step-by-step descriptions for connecting external frontends. Con-
necting procedures for relevant connector types are summarized for the R&S FE44S
as an example. Connecting to these connector types is analogous for all other external
frontends. The step-by-step descriptions cover the following topics:

® "To connect an R&S FE44S" on page 13

® "To connect an R&S FE50DTR" on page 15

® "To connect an R&S FE170ST or R&S FE110ST" on page 15

® "To connect multiple external frontends with coupled LO signal" on page 16

To connect an R&S FE44S

The following procedure describes how to connect the R&S SMM100A to an
R&S FE44S using the "RF" connector as IF signal output. The R&S FE44S and
R&S SMM100A are switched on and connected to power.

1. NOTICE! Cable selection. Use all cables delivered with the frontend. Other con-
nections can require additional cables.
For the IF connection, use the cable IF Connecting Cable Ext. FE as delivered with
the external frontend. The cable is available under order number 1347.7552.00.
For the reference signal connection and the LAN connection, use high-quality
cables.
See "Cable selection and electromagnetic interference (EMI)" in the
R&S SMM100A Getting Started.

2. NOTICE! Risk of SMA connector damage and cable damage. Excessive tightening
can damage the connecting cable, the SMA connectors and components inside the
R&S SMM100A.

Connect the "RF" connector of the R&S SMM100A with the "IF In" connector of the
R&S FE44S.
See also section "Connecting to RF" in the R&S SMM100A user manual.

3. Connect the "LAN" connector with the "LAN" connector of the R&S FE44S.
See also section "Connecting to LAN" in the R&S SMM100A user manual.
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Connecting external frontends

4. Check if the host name (1), IP address (2), subnet mask (3) and gateway address
(4) of the R&S FE44S are correct.
Once connected to LAN, the electronic label on the right side panel of the
R&S FE44S displays these network parameters:

For more information, see chapter "Electronic label" in the manual of the external
frontend.

5. Connect the "Ref Out" connector of the R&S SMM100A with the "Ref In" connector
of the R&S FE44S.

At the R&S SMM100A, you have two options:
e For 10 MHz reference frequency, use the BNC connector.
e For 1 GHz reference frequency, use the SMA connector.

See also the section "Connecting to Ref In/Ref Out" in the R&S SMM100A user
manual.

Table 3-4 and Figure 3-1 provide an overview on connections and a test setup.
Table 3-1: R&S SMM100A and R&S FE44S connections

Signal R&S SMM100A R&S FE44S

Reference Connector: "Ref Out" "Ref In"
Frequency: 1 GHz, 10 MHz

LAN (Control) "LAN" "LAN"

IF In "RF"/"RF" "IF In"

RF Out - "RF In/Out"

RF shield box

[Refout }—rei—>[Refin | .o
))) DUT

gonorator AN J—tan—]TAN ] FEAS
el LAN _—
& 1 Fn] [Foa}

E

Figure 3-1: Test setup with R&S FE44S in TX mode: Vector signal generator = R&S SMM100A,
R&S FE44S and RF shield box

Note, that the R&S FE44S can input (RX mode) or output (TX mode) one RF signal at
a time. For analyzing the input RF signal from the DUT, the R&S FE44S downconverts
the signal. Also, the R&S FE44S routes the resulting IF output signal to the signal ana-
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Connecting external frontends

lyzer. During RF signal analysis, the R&S FE44S does not process the IF input signal
from the R&S SMM100A.

For a more general test setup, see "OTA microwave test setup" on page 11.

To connect an R&S FE50DTR

The R&S FE50DTR and R&S SMM100A are switched on and connected to power. At
the R&S FE50DTR, you connect the IF input signal from the R&S SMM100A, to the "IF
In A" or "IF In B" connector.

» To connect an R&S FE50DTR with the R&S SMM100A, follow the instructions
described in section "To connect an R&S FE44S" on page 13.

Table 3-4 and Figure 3-2 provide an overview on connections and a test setup.
Table 3-2: R&S SMM100A and R&S FE50DTR connections

Signal R&S SMM100A R&S FE50DTR
Reference Connector: "Ref Out" "Ref In"
Frequency: 1 GHz, 10 MHz
LAN (Control) "LAN" "LAN"
IF In "RF" "IF In B"
RF Out - "RF Out B"
-E- IF OI ut RF shield box
R&S FSV/A LAN LAN: I_l IFOutA | | RFA |«—RF In— //
ISI?E?ODTR oot
Ref Gut _ _Y\\
R&S SMx LAN J-Aand —>| IFInB | | RFB [—RF Out-»
IF In

=

Figure 3-2: Test setup: R&S SMx = R&S SMM100A, R&S FSV/A, R&S FE50DTR and RF shield box

To connect an R&S FE170ST or R&S FE110ST

Note: The following procedure describes connecting an R&S FE170ST. Connecting an
R&S FE110ST is analogous.

The R&S FE170ST and R&S SMM100A are switched on and connected to power. At
the R&S FE170ST, you connect the IF input signal from the R&S SMM100A, to the "IF
In" connector.

» To connect an R&S FE170ST with the R&S SMM100A, follow the instructions
described in section "To connect an R&S FE44S" on page 13.

Table 3-3 and Figure 3-3 provide an overview on connections and a test setup.
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Table 3-3: R&S SMM100A and R&S FE170ST / R&S FE110ST connections

Signal R&S SMM100A R&S FE170ST

R&S FE110ST
Reference Connector: "Ref Out" "Ref In"

Frequency: 1 GHz, 10 MHz
LAN (Control) "LAN" "LAN"
IF In "RF" "IF In"
RF Out - "RF Out"
[RefOut }—ret—[Refin | .o RF shield box

e ) O

-
>
4
C
>
Z

RF Out
Fin—s] Fin | [ RFOut |-|

Figure 3-3: Test setup example: Vector signal generator = R&S SMM100A, R&S FE170ST and RF
shield box

For a more general test setup, see "OTA microwave test setup" on page 11.

To connect multiple external frontends with coupled LO signal

In a test setup with more than one external frontend, you can build a phase coherent
test setup when using the same LO signal for all connected frontends.

Connecting multiple devices by their used LO signals is useful, for example, in setups
with multiple input streams to reduce the phase noise. To use the same LO signal on
coupled external frontends, both devices have to use the same LO frequency for
upconversion and downconversion. For coupled frontends of the same type, e.g. two
R&S FE44S, make sure to select the same frequency band configuration for all fron-
tends.

You can also connect different models (one TX and one RX) of the same external fron-
tend type. For example, connect an R&S FE170ST and an R&S FE170SR or an

R&S FE110ST and an R&S FE110SR. Different models of the same external frontend
type can use different LO frequencies for the same output frequency setting. In this
case, use the "Shared LO" setting, which ensures that both devices use the same LO
frequency. See "Frequency Band Config" on page 35.

The frequency band configuration of the external frontend is stored on the device.

@ Since the "Shared LO" setting was introduced after product start, this setting is not yet
implemented on older devices. If you find the "Shared LO" setting is missing on your
R&S FE170ST or R&S FE170SR frontend and you require it, contact Rohde &
Schwarz support.
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Controlling external frontends

In a phase coherent test setup with multiple external frontends, you can use the LO
signal from either frontend. Couple the LO output and LO input of the external fron-
tends as shown in the examples with R&S FE170ST and R&S FE170SR. Use always
the reference signal of the external frontend providing the LO signal. Connecting an
R&S FE110ST to an R&S FE110SR or connecting other external frontends is analo-

gous.

Y
s Fen Fen T ] o
generator LAN FE170ST FE170SR LAN analyzer

[’ _}—Fn—s] Fin | [RFOut | —»[ DUT_J}—»L RFin | [IFout IF Oui—» RF Input 50 0

Figure 3-4: Example: Phase coherent test setup with LO signal from R&S FE170ST

See "To configure LO settings with multiple external frontends" on page 26.

LO Out <—Ref Ref Output x MHz
Vector signal -_ R&S R&S -_ Signal
generator LAN T FE170SR LAN: el

[ ’RF_}—Fn—s] Fin | [RFOut | —»] DUT_J—»L RFin | [IFout |—IFou RF Input 50 Q

Figure 3-5: Example: Phase coherent test setup with LO signal from R&S FE170SR

For more information, see the user manual of the signal analyzer.

You can only connect external frontends of the same type together, which cover the
same frequency range, e.g. two R&S FE44S or one R&S FE170ST and one
R&S FE170SR.

1. Connect the R&S FE170ST to the signal generator.
See "To connect an R&S FE170ST or R&S FE110ST" on page 15.

2. Connect the "LO Out" connector of the R&S FE170ST to the "LO In" connector of
the R&S FE170SR.

3.2 Controlling external frontends

This chapter provides step-by-step descriptions for controlling, updating and operating
external frontends with the R&S SMM100A. The descriptions cover the following top-
ics:

® "To configure the R&S SMM100A for frontend control" on page 18

® "To configure external frontend settings" on page 20

® "To configure frequency band settings for R&S FE44S or R&S FE50DTR"
on page 21

® "To configure frequency band settings for R&S FE170ST or R&S FE110ST"
on page 21
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Example "IF and frequency band configuration for R&S SMM-B1006 and
R&S FE44S" on page 22

"To work with R&S FE50DTR Simultaneous RX/TX connection mode" on page 23
"To handover frontend control to signal analyzer" on page 24

"To add external devices to the external frontend" on page 24

"To choose an external filter" on page 25

"To connect an external device" on page 25

"To check for external devices" on page 25

"To configure LO settings with multiple external frontends" on page 26

To configure the R&S SMM100A for frontend control

The following procedure describes how to configure the R&S SMM100A to establish a
control connection between R&S SMM100A and an external frontend. The
R&S SMM100A is connected to the external frontend.

See "To connect an R&S FE44S" on page 13.

1.

In the taskbar, select "System Config" > "System Configuration" > "External RF und
1/Q".

Select "RF" > "External Instrument" > "Config".

The "Remote Instrument" dialog opens.

Select the connected external frontend from "External Instrument" selection.
The selection displays available instruments in format
<product>-<serial number>, for example "FE44S-123456".

In the field "Hostname or IP Address", check if the host name or IP address of the
connected external frontend is correct.

If read out correctly, the host name or IP address match with the information dis-
played on the electronic label of the external frontend.

See step 4) in the section "To connect an R&S FE44S" on page 13.

Select "Apply and Connect".
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RF A: External Instrument Configuration X

Remote Instrument Show Connector

[
Scan X Clean Unused = Clean All
External Instrument . Set Symbolic Name ©
FE445-123456

Remote Channel © " Hostname or IP Address )

Frontend Connection FE445-123456
Device ID e

FEA45-123456
+ Apply £ Apply and Connect ﬁ Frontend Config >

A message displays if the remote connection to the external frontend is established
or not.

o (A)External frontend - Connected »-

Figure 3-6: Message displaying an established remote connection

If connected successfully, you can configure dedicated frontend settings in the
"Frontend Configuration" dialog.

See "To configure external frontend settings" on page 20.
6. Select "System Config" > "System Configuration" > "External RF und I/Q".
System Configuration X

Multi Instrument I/Q Stream Mapper |External RF and I/@ Overview

Display

. Auto Connect
Mapped Connectors

Connect All Remote Disconnect All Remote

Preset behavior: Keep connections to external instruments

oty IE:stte}Tnilent II{S'm E:I:n s et 02 E:up RF l:r(‘le-l‘.]zl-)lem ‘R(Zléen:?l EtFate
CODER1 | In  Config...
I/QOUT1| Out  Config... éingle
nded
RF Out  Config... . FE445-123456 v A:0.00 A:0.00 Off

The dialog displays the settings and state of the connected external instrument.

The "RF" > "Rem Conn" field displays an active control connection:
|

The control connection is established, the LAN LED on the external frontend
switches from green to orange.
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If you change the network configuration, e.g. the IP address, the connection to the
R&S SMM100A is aborted. Re-establish a connection to the frontend as in step 3).

If you change the network configuration, e.g. the IP address, the connection to the
R&S SMM100A is aborted. Re-establish a connection to the frontend as in step 3).

If you have connection issues, see Chapter 5, "Troubleshooting Frontend Control",
on page 47.
To configure external frontend settings

The following procedure describes how to configure external frontend settings at the
R&S SMM100A.

See Chapter 4.2.1, "General settings", on page 33.

The R&S SMM100A is connected to an external frontend and a remote control connec-
tion between R&S SMM100A and the external frontend is established.

See "To configure the R&S SMM100A for frontend control" on page 18.

1. Select one of the following in the block diagram:
e Select the icon of the connected external frontend to the right of the "RF" block.
e Select "RF" > "RF Frontend" > "Frontend Device".

2. Set the frequency of the reference signal between R&S SMM100A and external
frontend, e.g., "1 GHZz".

3. Optionally, change the "Connection Mode".
For "Connection Mode" > "Auto", the R&S SMM100A reads out the frontend infor-
mation automatically, for example intermediate frequency (IF) and frequency band
configuration.

4. Set the "Frequency Band Configuration".

See

e "To configure frequency band settings for R&S FE44S or R&S FE50DTR"
on page 21

e "To configure frequency band settings for R&S FE170ST or R&S FE110ST"
on page 21

Also, the R&S SMM100A sets and reads out the following parameters automati-
cally at the external frontend:

e '"Intermediate Frequency / Sideband": Frequency of the IF input signal input
e "Active RF Connector": RF output connector
e "Frequency Band x": Frequency ranges of the RF output signal

For more information, refer to the specifications document.
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To configure frequency band settings for R&S FE44S or R&S FE50DTR

Test setups typically require a defined setting of the frequency band configuration.
Configure this setting in the "RF Frontend" dialog of the R&S SMM100A.

1. Set the "Mode" for the "Frequency Band Configuration".
e "Auto": Configures the frequency band automatically.
e "Manual": Configures the frequency band manually.

2. To define IF range and internal LO of the R&S FE44S or R&S FE50DTR, set the
"Frequency Band Config" mode:

e "IF Low": Sets IF low mode.

The R&S SMM100A sets an IF frequency below 7.5 GHz.
e "IF High": Sets IF high mode.

The R&S SMM100A sets an IF frequency above 7.5 GHz.

The used IF and the used frequency band of the RF input signal are set automati-
cally.

RF Frontend : FE445-123456 X

Settings = Versions / Options Attenuator Cable Correction Network LO Config

Reference Frequency . Connection Mode .
1GHz Auto
Intermediate Frequency / Sideband ©  Active RF Connector ©
4.125 000 000 000 GHz / USB RFA
Frequency Band Configuration
Mode v
Auto
Frequency Band Config ©  Frequency Band 1 @
IF Low 24.00 GHz ... 44.00 GHz

Figure 3-7: Example: Frontend configuration FE44S

For information on how to generate output signals, see "To output the external frontend
RF signal with R&S FE44S" on page 27.

To configure frequency band settings for R&S FE170ST or R&S FE110ST

Test setups typically require a defined setting of the frequency band configuration.
Configure this setting in the "RF Frontend" dialog of the R&S SMM100A.

Note: This procedure describes configuring the R&S FE170ST as an example. Config-
uring the R&S FE110ST is analogous.

1. Set the "Mode" for the "Frequency Band Configuration".

e "Auto": Configures the frequency band automatically.
e "Manual": Configures the frequency band manually.

2. To define IF range and internal LO of the R&S FE170ST, set the "Frequency Band
Config" mode:
e "Spur Optimized":
Default value in "Auto" mode.
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The external frontend uses a frequency band that avoids any distortion from
the LO or image frequencies.
e "EVM Optimized":
The external frontend uses a frequency band that provides an optimized EVM.
The used IF and the used frequency band of the RF input signal are set automati-

cally.
For required frequency options, see Table 4-2.

RF Frontend : FE170ST-123456 -_— X

Settings  Versions / Options Attenuator Cable Correction Network External Devices LO Config

Reference Frequency . Connection Mode .
1 GHz Auto
Intermediate Frequency / Sideband ©  Active RF Connector e
31.000 000 000 00 GHz / LSB RFA
Frequency Band Configuration
Mode v
Auto
Frequency Band Config ©  Frequency Band 1 ©
Spur Optimized 110.0 GHz ... 175.0 GHz

Figure 3-8: Example: Frontend configuration FE170ST

For information on how to generate output signals, see "To generate an RF signal with
R&S FE170ST" on page 28.

Example: IF and frequency band configuration for R&S SMM-B1006 and
R&S FE44S

The example shows the IF value for IF low frequency band configuration:

® ‘"Intermediate Frequency / Sideband" > "4.125 GHz / USB": Frequency of the IF
signal for IF low mode ("Frequency Band Config" > "HWS")

® "Active RF Connector" > "RF A": RF output connector at R&S FE44S

® "Frequency Band 1" > "24.00 GHz ... 44.00 GHZz": Frequency range of the RF out-
put signal

RF Frontend : FE445-123456 — X

Settings Versions / Options Attenuator Cable Correction Network LO Config

Reference Frequency .| Connection Mode .
1 GHz Auto
Intermediate Frequency / Sideband ©  Active RF Connector ©
5.500 000 000 000 GHz / USB RF A
Frequency Band Configuration
Mode -
Auto
Frequency Band Config ©  Frequency Band 1 ®
IF Low 24.00 GHz ... 44.00 GHz
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To work with R&S FE50DTR Simultaneous RX/TX connection mode

The following procedure describes how to activate and to work with "Simultaneous
RX/TX" connection mode of the R&S FE50DTR external frontend. This connection
mode requires a test setup consisting of a signal generator, an R&S FE50DTR and a
signal analyzer. Table 3-4 shows an example using R&S SMM100A and R&S FSV/A.

Table 3-4: R&S SMM100A, R&S FE50DTR and R&S FSV/A connections

Signal R&S SMM100A R&S FE50DTR R&S FSV/A
Reference Connector: "Ref Out" "Ref In" -
Frequency: 1 GHz,
10 MHz
LAN (Control) "LAN" "LAN" "LAN"
IF In "RF" "IF In B" -
IF Out - "IF Out A" "RF Input 50Q"
RF In - "RF A" -
RF Out - "RF B" -

For a test setup, see Figure 3-2.

1. Select "RF" > "RF Frontend" > "Frontend Device".
2. Select "Connection Mode" > "Simultaneous RX/TX".

3. Wait until the R&S SMM100A establishes a lock at the connected R&S FE50DTR.

Once a lock is established successfully, the R&S SMM100A sets the intermediate
frequency (IF) at R&S FE50DTR. In the "RF Frontend" dialog, the displayed IF
value "Intermediate Frequency" > "Unavailable due to missing lock" changes to a
value dependent on the RF frequency, e.g. "Intermediate Frequency" >

"3.890625 GHZz".
RF Frontend : FES0DTR-123456 — X
Settings  Versions / Options Attenuator Cable Correction Network LO Config
Reference Frequency Connection Mode .
1 GHz Simultaneous RX/TX
Intermediate Frequency / Sideband ©  Active RF Connector ®
3.890 625 000 000 GHz / USB RFB
Frequency Band Configuration
Mode
v
Auto
Frequency Band Config ©  Frequency Band 1 @
IF Low 36.00 GHz ... 50.00 GHz

Note: Intermediate frequency and frequency band configuration. Intermediate fre-
quencies depend on the hardware equipment of the R&S SMM100A, the signal
analyzer and the R&S FE50DTR.

See also Table 4-1.

For more information, refer to the specifications document.
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4. Make sure that this IF value is the same for the IF out signal at the signal analyzer.
For example, at the R&S FSV/A, check the following:

a) To navigate to the frontend configuration, select "Overview"" > "Input" > "Input
Source Config" > "Input Source" > "External Frontend" > "Frontend Config".

b) In "Frequency Settings" panel of the "Frontend Config" tab, check "Intermediate
Frequency".

InpE

Input Source  Probes

Radio Global Config = Frontend Config Diagnostics
Frequency
Frequency Settings

External Frequency Band 36 - 50 GHz
Mixer

Reference Frequency 10 MHz
External

Frontend Intermediate Frequency 3.90234375 GHz

I/Q File

Correction State

Load Cable Correction 52P File

To handover frontend control to signal analyzer

If two instruments, e.g. a R&S SMM100A and a signal analyzer, are connected to the
R&S FE50DTR and the connection slot of the R&S SMM100A is locked, the signal
analyzer can control the R&S FES50DTR via the second slot. The signal analyzer sets
the RX path at the R&S FE50DTR and reads out the frequency band configuration.
This information is needed to derive the RF frequency from the DUT from the mea-
sured IF input frequency.

To add external devices to the external frontend

External devices are available for the following external frontends:
e R&S FE170ST
e R&S FE110ST

You can add accessories, for example a bandpass filter or an amplifier, as external
devices to a test setup with R&S SMM100A and an external frontend. The external
devices transmit the RF input via their waveguide connector. Power and device data is
transmitted via an IX type B connector with an SPI interface.

The IX type B connector allows you to connect external devices to the external fron-
tend. External devices can amplify or filter the upconverted RF signal. Using an IX
cable, correction data and device information for the external device is transferred to
the external frontend and to the connected R&S SMM100A. Thus, the R&S SMM100A
cannot only detect the external devices, but also consider their correction data in the
RF measurement.

See also the installation instructions and specifications document of the external fron-
tend.
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RF Out YV IV VYIS
Ref—> RES RFOut ———[in| [out-RFge/in| Tout—RF RF shield box
Vector signal
somoratn LAN LAN—— FE170ST Amplifier Sand- ))) RU

i Y NNNNIVIVIIII
Ix
X

Figure 3-9: Test setup: Vector signal generator with R&S FE170ST and external devices

RF Out YMAAAAAAAAAA,
Ref Out Ref—> R&S RFOut ———» in out—RF RF shield box
Vector signal TAN LAN FE110ST Band- )) DUT
generator filter

lF " ? PLDAANNANNNNNS
X

Figure 3-10: Test setup: Vector signal generator with R&S FE110ST and external device

To choose an external filter

The supported frequency ranges of the available external filters overlap. For best
results regarding image suppression and LO feedthrough, see the specifications docu-
ment of the external device.

See the R&S FE170-Zxx or R&S FE110-Zxx accessories specifications document:
® www.rohde-schwarz.com/brochure-datasheet/fe170st
® www.rohde-schwarz.com/brochure-datasheet/fe110st

To connect an external device

1. Connect the RF output of the external frontend to the RF input of the external
device.

2. Connect the IX connector of the external frontend with the cable provided with the
device to the IX type B connector on the external device.
To connect two external devices, connect the IX Y-cable provided with the external
frontend to both external devices.

Note: You can add only one external device of the respective type to the test
setup.

3. Connect the RF output of the external device to the DUT.
4. Connect the external frontend to the R&S SMM100A.

To check for external devices

You can check which external devices are connected in the signal path between the
DUT and the external frontend.

1. Select one of the following in the block diagram:
e Select the "FE..." icon to the right of the "RF" block.
e Select "RF" > "RF Frontend" > "Frontend Device".
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2. Select the "External Devices" tab.

The devices that are connected to the external frontend via the IX type B connector
and which were detected by the R&S SMM100A are indicated.

Settings Versions / Options Attenuator Cable Correction Network | External Devices LO Config

{/', Refresh External Devices

External Device 1 External Device 2
Connected Device ©  Connected Device ®
FE170_Z50 FE170_201
Type ® Type Q
Amplifier Filter
Frequency Range © " Frequency Range e
110.0 GHz ... 170.0 GHz 110.0 GHz ... 170.0 GHz
Gain e
10.0 dB
Additional External Device Correction
State off E E Load Correction File o
Figure 3-11: Example: External devices connected to an R&S FE170ST
3. If necessary, update the display by selecting "Refresh External Devices".
Alternatively:
a) Select "I/Q Stream Mapper" in the block diagram.
b) Select "External RF and 1/Q" > "External Instrument" > "Config".
c) Select "Clean All".
This step removes all connected external Instruments.
d) Select "External Instrument".
e) Select a device from the list.
f) Click "Apply and Connect".
See Chapter 4.2.6, "External devices settings", on page 43.
To configure LO settings with multiple external frontends
1. Select one of the following in the block diagram:
e Select the icon of the external frontend to the right of the "RF" block.
e Select "RF" > "RF Frontend" > "Frontend Device".
2. Select the "LO Config" tab.
RF Frontend : FE445-123456 X

Settings  Versions / Options Attenuator Cable Correction Network LO Config

Mode
v
Internal
Out State
v
Off

3. Select the "Mode".

a) If the external frontend connected to the vector signal generator provides the
LO signal in your test setup, select "Internal”.
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b) If the external frontend connected to the vector signal generator receives the
LO signal in your test setup, select "External”.
The "Mandatory LO IN Frequency" is displayed.

4. Select the "Out State".

a) If the external frontend connected to the vector signal generator provides the
LO signal in your test setup, select "On".
The "LO OUT Frequency" is displayed.

b) If the external frontend connected to the vector signal generator receives the
LO signal in your test setup, select "Off".

5. If you use the TX-model and the RX-model of the external frontend type in your
test setup, e.g. R&S FE170ST and R&S FE170SR or R&S FE110ST and
R&S FE110SR:

a) Select the "Settings" tab.
b) Select "Mode" > "Manual".
c) Select "Frequency Band Config" > "Shared LO".

Frequency Band Configuration
Mode
v
Manual
Frequency Band Config . Frequency Band 1
Shared LO 110.0 GHz ... 175.0 GHz

[

Both external frontends now use the same LO frequency.

Note: The "LO Config" settings are a generalized case of "Shared LO". It is not
mandatory to connect the LO out signal of the R&S FE170ST or R&S FE110ST to
another external frontend. You can use the signal also for other requirements in
your test setup.

3.3 Generating RF output signals

To output the external frontend RF signal with R&S FE44S

The procedure assumes, that a remote control connection between R&S SMM100A
and R&S FE44S is established, see "To configure the R&S SMM100A for frontend con-
trol" on page 18.

1. Configure the output RF signal.
Once you connect the external frontend, the R&S SMM100A sets the "Frequency"
in the status bar automatically. In particular, the R&S SMM100A sets the lower fre-
quency of the frequency band, i.e. 24 GHz.

2. In the status bar of the R&S SMM100A, adjust the frequency and level of the RF
signal that is output at the external frontend.

3. In the block diagram, select "RF > On".
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Frequency I PEP Level
24.000 000 000 000 6+ | |G- = 30,00 éém -30.00 ésm
T E L P (\.?

Baseband AWGN

T D —
om
(o] AWGN

| Click to conﬁgure...|

1/Q Stream Mapper

BB Input

CODER 1

:go 1/ out

=A

To generate an RF signal with R&S FE170ST

With the R&S FE170ST connected to the R&S SMM100A, you can generate RF sig-
nals with frequencies in the high D band, for example 5G signals.

The procedure assumes that a remote control connection between R&S SMM100A
and R&S FE170ST is established (see "To configure the R&S SMM100A for frontend
control" on page 18) and the frontend settings are configured (see "To configure exter-
nal frontend settings" on page 20).

In this example, you generate a 5G NR uplink signal with Frequency = 140 GHz and 2
GHz bandwidth (i.e. no bandwidth extension is used).

1. Select "Baseband > 5G NR".
In the "General" tab, select "Link Direction > Uplink".

2

3. Select "State > On".

4. Return to the block diagram.
5

Configure the RF output signal.

Once you connect the external frontend, the R&S SMM100A sets the "Frequency"
in the status bar automatically. In particular, the R&S SMM100A sets the lower fre-
quency of the frequency band, i.e. 110 GHz.

6. In the status bar of the R&S SMM100A, adjust the frequency of the RF signal.
7. Inthe status bar of the R&S SMM100A, adjust the level of the RF signal.

8. In the block diagram, select "RF > On".
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The RF signal is output at the external frontend.

Frequency I PEP Level
140,000 000 000 00+ | 6 = 30.00¢8m  -30.00 o
T E L P 9
Baseband AWGN | , . 1/Q@ Mod RF FE170ST ...

ocC AWGN

1/Q Stream Mapper

CODER 1 BB Input

&
7_@;0 I/Q OUT

=A

3.4 Updating the firmware

Correct frontend operation can require a firmware update for the microcontroller of the
external frontend. When the R&S SMM100A establishes a connection to the frontend,
it checks the firmware version of the frontend and compares it with firmware version
provided with the option R&S SMM-K553.

The firmware versions can differ as follows:

® R&S SMM-K553 firmware version is higher than the firmware version installed on
the external frontend.
This situation can occur, for example, after installing a new R&S SMM100A firm-
ware. Upgrade the firmware of the external frontend, see "To update the frontend
firmware" on page 30.

® R&S SMM-K553 firmware version is lower than the firmware version installed on
the external frontend.
This situation can occur, for example, if you use an older R&S SMM100A firmware
and you buy an external frontend that uses a new firmware for its microcontroller.
Downgrade the firmware of the external frontend. Firmware downgrade is analo-
gous to a firmware upgrade.

R&S SMM100A operation mode

If you operate the R&S SMM100A remotely, connecting to an external frontend auto-
matically updates an outdated firmware of the external frontend. If you operate the
R&S SMM100A manually, see the following step-by-step description.
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To update the frontend firmware

This step-by-step description assumes that the R&S SMM-K553 firmware version is
higher than the firmware version installed on the external frontend. The procedure with
a lower firmware version is analogous.

1. Establish a control connection to the external frontend. See "To configure the
R&S SMM100A for frontend control" on page 18.
After selecting "Apply and Connect”, a dialog opens automatically and asks you to
update firmware of the external frontend.

External Frontend Firmware Update

S 4

\il) Firmware update necessary.

Start external frontend firmware upgrade from 2.1.15 to 2.1.16

Cancel

2. Select "OK" for automatic update of the firmware.
A dialog opens indicating a running firmware upgrade procedure.

X

External Frontend Firmware Update

\il) External frontend firmware upgrade in progress. Please be patient
and do not disconnect or switch off signal generator or external frontend.

This may take up to a minute.

3. NOTICE! Risk of firmware update failure. Never disconnect or switch off the signal
generator or the external frontend during a firmware update.

Wait until the procedure finishes.

If the firmware update is successful, the R&S SMM100A displays a notification
message.

199: 2021-05-28 18:09:48.042, Level: Info, Code: 170009
External frontend firmware update performed successfully
SCPI: Info

4. Optionally, check that the new firmware is installed on the external frontend.

a) Select "Frontend Configuration”.
b) In the dialog "RF Frontend" dialog, select the tab "Versions / Options".

The "Hardware Config" table lists the version of the firmware installed on the exter-
nal frontend in the column "Revision".
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Hardware Config

Assembly Part Number Serial Number ‘Revision ‘
FE445 1234.5678.00 123456 01.01

FE445-123456-Mic 00.00.00

FE44S_Synthesizer 1338.6570.02 100000 01.00

FE445_Frontend 1338.7282.02 101173 |2.1.1S

If you want to update the firmware on the frontend later, select "Cancel". The
R&S SMM100A displays a notification message.

199: 2021-10-22 14:16:17.970, Level: Error, Code: 170008
External frontend firmware update error - Firmware update aborted.
SCP!I: Device specific error

Canceling the firmware update also aborts the connection to the external frontend.
The frontend is not available for use with the R&S SMM100A until you perform the
update. The R&S SMM100A displays a notification message.

200: 2021-10-22 14:16:17.972, Level: Error, Code: 20005
Settings conflict - FESODTR-111111 is not reachable
SCPI: Settings conflict
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4 External frontend configuration and settings

o  External RF SettiNgS.....coci oo
o RF frontend SettiNgS....cco oo i —————

4.1 External RF settings

Access:

> Select "Taskbar" > "System Config" > "System Configuration" > "External RF and
1/Q".

System Configuration —

Multi Instrument |/Q Stream Mapper |External RF and I/@ Overview

Displ . Auto C t
spray v  Connect All Remote Disconnect All Remote uto tonnec
Mapped Connectors

Preset behavior: Keep connections to external instruments

RF
State

RF Level
(dBm)

RF
Coup

RF Frequency

Rem
(Hz)

Conn

I/Q
Conn

External
Instrument

Instrument Name

Dir

CODER1 | In  Config...

YQOUT1| Out Config.. oo

RE out  Config.. [Z] reaasazzase v £:000 4:000 OFf

The dialog provides information and settings about connected external instru-
ments.

For a description of the external RF settings, see chapter "External RF and 1/Q set-
tings" in the R&S SMM100A user manual.

Remote connection status
Indicates the status of the remote connection. Click the status indicator to toggle the

remote connection status.
The "Rem Conn" field displays an active control connection: B

Remote command:
[ : SOURce<hw>] :EFRontend:CONNection:STATe on page 55
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4.2

4.2.1

RF frontend settings

RF frontend settings

Access:

» Select one of the following in the block diagram:
e Click the "FE ..." icon to the right of the "RF" block.
For example, the icon displays "FE44S" for an R&S FE44S connected to the
R&S SMM100A.
e Select "RF" > "RF Frontend" > "Frontend Device".

The remote commands required to define the settings are described in Chapter 6.1,
"SOURce:EFRontend subsystem", on page 49.

To operate an external frontend with the R&S SMM100A

See Chapter 3, "Operating external frontends", on page 13.

Settings:

@ General SEHINGS.....cii i e e aaas 33
e \ersions and options iNformMation............ccuueeeeiiire e 37
0 AttenUAator SEHINGS...cooo e ————— 39
o Cable correction SettiNgS.......cooiiii i —————— 40
0 NEtWOIK SEHINGS. coeiiiiii i e e e e e e e e eeas 42
o External deviCes SetliNgS...couui oo 43
0  LO CONFig SEHINGS. ..ceii it 45

General settings

Access:
1. Select "RF" > "RF Frontend" > "Frontend Device".

2. Select "Settings".

RF Frontend : FE445-123456 -_— X
Settings Versions / Options Attenuator Cable Correction Network LO Config
Reference Frequency .| Connection Mode .
1 GHz Auto
Intermediate Frequency / Sideband ©  Active RF Connector &
5.500 000 000 000 GHz / USB RF A
Frequency Band Configuration
Mode v
Auto
Frequency Band Config ©  Frequency Band 1 @
IF Low 24.00 GHz ... 44.00 GHz

The "Settings" tab provides settings to configure reference frequency and connec-
tion settings for the connected external frontend.
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Settings

REfErenCe FrEQUENCY ....cccoi it e e 34

(070] o] a =T i o] T 1Y FoTo =TSP 34

Intermediate Frequency / Sideband...........cceoveeiiiiiiiiiiiiiiieeece e 35

ACHVE RF CONMNECION. ..cciiiiiiiiii ittt e e e e e e e e e e e e e eeas 35

Frequency Band Configuration..............eeuuiiiiiiiiiiiieie e 35
L MO 1.ttt 35
L Frequency Band CONfig.........cceueueueeeveeeeeeeeeeeeeeeeeeeteseessesseesesenesasaesssesssesesnas 35
L FreqUeNCY BanG X......cvoveveveeeecececeeeeeeteeeeseseseesesessessssssesesssssssssssssesasassssssssasanns 37

Reference Frequency
Sets the frequency of the reference signal between R&S SMM100A and frontend.

The R&S SMM100A provides reference frequencies of 10 MHz and 1 GHz.
"1GHZz" Requires R&S SMM-B10xx/B20xx, i.e. a four-digit frequency option.

Remote command:
[ : SOURce<hw>] :EFRontend: FREQuency:REFerence on page 58
[ :SOURce<hw>] :EFRontend: FREQuency:REFerence:LIST? on page 58

Connection Mode
Sets the mode of the SSL control connection between R&S SMM100A and external
frontend.

There is one communication channel to control the external frontend meaning that one
instrument controls the external frontend exclusively.

Once the external frontend is locked, the R&S SMM100A firmware reads out external
frontend characteristics such as intermediate frequency (IF) and frequency bands.

"Auto" The R&S SMM100A locks the external frontend, when activating the
RF output at the R&S SMM100A ("RF" > "On") for output of the IF
signal.

The R&S SMM100A unlocks the external frontend, when deactivating
the RF output at the R&S SMM100A ("RF" > "Off").

"Lock" The external frontend is locked permanently. No other instrument can
take over control.

"Simultaneous RX/TX"
Requires an R&S FE50DTR connected to the R&S SMM100A.
Connection mode for simultaneous RX (receive) operation and TX
(transmit) operation of an R&S FE50DTR.
Set this mode if your test setup requires a release of connection lock.
A connected vector signal analyzer can lock the external frontend for
RX operation.
How to: "To work with R&S FE50DTR Simultaneous RX/TX connec-
tion mode" on page 23

Remote command:
[ : SOURce<hw>] :EFRontend:CMODe on page 56
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Intermediate Frequency / Sideband
Displays the frequency of the IF signal that is the frequency at the "RF" connector of
the R&S SMM100A.

Also, the sideband of the IF signal is displayed after the frequency. "USB" means upper
sideband, "LSB" means lower sideband.

If the lock of the communication channel is missing, the intermediate frequency dis-
plays "Unavailable due to missing lock".

If you use R&S FES50DTR-type frontends with an analyzer and a signal generator
simultaneously, make sure that the set "Intermediate Frequency" is identical on both
instruments.

Remote command:

[ :SOURce<hw>] :EFRontend[ : FREQuency] : IFRequency|[ :VALue] ?

on page 59

[ : SOURce<hw>] :EFRontend: FREQuency: IFRequency: SIDeband? on page 59

Active RF Connector
Displays the RF output connector that is active at the connected external frontend. The
RF output signal is the up-converted RF signal.

"RF A" RF output connector at the R&S FE44S, R&S FE170ST or
R&S FE110ST.

|IRF Bll
RF output connectors at the R&S FE50DTR.

Remote command:
[ : SOURce<hw>] :EFRontend:RFConnector on page 61

Frequency Band Configuration
Provides frequency band parameters of the external frontend.

Mode «— Frequency Band Configuration
Sets the mode for frequency band configuration of the external frontend.

See "Frequency Band Config" on page 35
"Auto" Configures the frequency band automatically.

® R&S FE44S and R&S FE50DTR:

For bandwidths < 400 MHz, "IF Low" is used.

For bandwidths larger than 400 MHz, "IF High" is used.
® R&S FE170ST and R&S FE110ST:

"Spur Optimized" is used.

"Manual" Configures the frequency band configuration manually as defined in
Frequency Band Config.

Remote command:
[ : SOURce<hw>] :EFRontend: FREQuency: BAND: CONFig:MODE on page 57

Frequency Band Config — Frequency Band Configuration
Define the intermediate frequency (input) range of the external frontend.
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The used Intermediate Frequency / Sideband and the resulting Frequency Band x are
indicated for reference.

You can use R&S FE50DTR-type frontends simultaneously by an analyzer and a signal
generator, see "Connection Mode > Simultaneous RX/TX". In this case, both channels
(RX, TX) use the same internal local oscillator and thus both signal paths operate on
the same frequency. Therefore, if you want to analyze the signal from the generator
using the same frontend, make sure that the configured frequency bands are identical
on both instruments.

To use the extended analysis bandwidth option B1000 at the signal analyzer, the exter-
nal frontend must downconvert all RF input signals to an IF frequency above 7.5 GHz.
In this case, you must set the frequency band to "IF High". For details, see Table 4-1.

Table 4-1: Simultaneous RX/TX mode and analyzer/signal generator equipment

Analyzer model Analyzer Analysis Signal generator | "Band Config"
hardware bandwidth hardware

R&S FSV(A)3007 | </= B400 </= 400 MHz B1006, B1007 "IF Low"
</= B400 </= 400 MHz >/=B1012 "IF Low"

R&S FSV(A)3013 | </= B400 </= 400 MHz B1006, B1007 "IF Low"

R&S FSV(A)3030 | </=B400 </= 400 MHz >/=B1012 "IF Low", "IF High"

R&S FSV(A)3044 | >/=B1000 </= 400 MHz B1006, B1007 "IF Low"
>/=B1000 > 400 MHz B1006, B1007 -
>/=B1000 </= 400 MHz >/=B1012 "IF Low", "IF High"
>/=B1000 > 400 MHz >/=B1012 "IF High"

Frontends supporting D band signals (110 GHz to 170 GHz), e.g. R&S FE170ST, or W
band signals (75 GHz to 110 GHz), e.g. R&S FE110ST, need hardware options to opti-
mize EVM or to avoid distortions via the frequency band configuration.

Table 4-2: Signal generator equipment for high frequency bands

External Frontend Signal generator hardware "Band Config"

R&S FE170ST >/=B1020 "EVM Optimized"
>/=B1031 "Spur Optimized"
>/=B1020 "Shared LO"

R&S FE110ST >/=B1020 "EVM Optimized"
>/=B1020 "Spur Optimized"
>/=B1020 "Shared LO"

"</=" denotes lower or equal, ">/=" denotes higher or equal.

"IF Low" A lower intermediate frequency is used on the external frontend,
resulting in a lower output frequency at the R&S SMM100A.

"IF High" A higher intermediate frequency is used on the external frontend,
resulting in a higher output frequency at the R&S SMM100A.
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"Spur Optimized"
The external frontend uses a frequency band that avoids any distor-
tion from the local oscillator or image frequencies.

"EVM Optimized"

The external frontend uses a frequency band that provides an opti-
mized EVM.

"Shared LO" The TX-model and the RX-model of an external frontend type in the
test setup, e.g. R&S FE170ST and R&S FE170SR or R&S FE110ST
and R&S FE110SR, use the same LO frequency according to a pre-
defined frequency plan. The frequency plan determines which LO fre-
quency belongs to which set output frequency.

Remote command:
[ :SOURce<hw>] :EFRontend: FREQuency:BAND:CONFig:CATalog? on page 57
[ : SOURce<hw>] :EFRontend: FREQuency:BAND:CONFig: SELect on page 57

Frequency Band x < Frequency Band Configuration
Displays the ranges of the frequency bands of the upconverted frequency depending
on the connected external frontend.

Frontends without gaps between upconverted frequencies have one frequency band,
frontends with gaps have two or more frequency bands. For supported frequency
ranges, see the specifications document.

Example: R&S FE44S and R&S FE50DTR frequency bands

This example illustrates frequency bands for R&S FE44S and R&S FE50DTR. The
R&S SMM100A is equipped with frequency option R&S SMM-B1006.

® RG&S FE44S: One frequency band from 24.00 GHz to 44.00 GHz
e R&S FE50DTR: Two frequency bands from 36.00 GHz to 42.00 GHz and
46.40 GHz to 50.00 GHz

Remote command:

[ : SOURce<hw>] :EFRontend: FREQuency: BAND: COUNt ? on page 56

[ : SOURce<hw>] :EFRontend: FREQuency : BAND<ch>:LOWer? on page 58
[ : SOURce<hw>] :EFRontend: FREQuency : BAND<ch>:UPPer? on page 58

Versions and options information

Access:

1. Select "RF" > "RF Frontend" > "Frontend Device".
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2. Select "Version / Options".

Settings  Versions / Options Attenuator Cable Correction Network LO Config

Firmware

Package |Versinn
Frontend Control Server 00.00.01
Frontend Control Library 01.36.02

Hardware Config

Assembly Part Number Serial Number Revision
FE445 1234.5678.00 123456 01.01
FE445-123456-Mic 00.00.00
FE445_Synthesizer 1338.6570.02 100000 01.00
FE44S_Frontend 1338.7282.02 101173 03.02

The "Versions / Options" tab displays information on the firmware and hardware of
the connected external frontend.

Settings:
FIIMWATE. ... ettt e e e ettt e e e e e e e e e e s eeeeeeeeeas 38
Hardware CONfig.......eieieiiiiiiicicciieie e e ettt e s e s e s e e e eeaaaaaaaaeeeeeeenes 38
Firmware

Displays firmware information on the control server and control library of the external
frontend. The information is displayed in a table and consists of installed packages and

versions.
"Package" Comprises the frontend control server and frontend control library.
"Version" Denotes the version of the installed package.

Remote command:
n.a.

Hardware Config

Displays hardware information of the hardware components of the external frontend.
The information is displayed in a table and consists of component name, its part num-
ber and serial number, and revision version.

"Assembly" Displays the assembly part name for hardware component.
"Part Number" Displays the part number for each hardware component.

"Serial Number"
Displays the serial number for each hardware component.

"Revision" Displays the revision version for each hardware component.

Remote command:
[ :SOURce<hw>] :EFRontend: IDN? on page 58
[ :SOURce<hw>] :EFRontend:OPT? on page 60
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4.2.3 Attenuator settings

Access:
1. Select "RF" > "RF Frontend" > "Frontend Device".

2. Select "Attenuator".

Settings  Versions / Options 'Attenuator Cable Correction Network LO Config

Mode

v
Auto

The "Attenuator" tab provides settings to configure attenuation.

Settings:

1Y [ Yo = T 39
PN (=Y LU F= i o F TR 39
(017575 P 39
Mode

Sets the attenuator mode of the external frontend.

"Auto" Sets the attenuation value automatically.
The frontend control connection provides this attenuation value from
the connected external frontend.

"Auto & Offset"
Requires frontend R&S FE170ST or R&S FE110ST.
You can define an offset value which adds to the attenuation value
provided from the connected external frontend.

"Manual" Sets an attenuation value manually.

Remote command:
[ : SOURce<hw>] :EFRontend: AMODe on page 55

Attenuation
Requires "Mode > Manual".

Sets the attenuation of the external frontend.

Remote command:
[ : SOURce<hw>] :EFRontend: POWer:ATTenuation on page 61

Offset
Requires frontend R&S FE170ST or R&S FE110ST.

Requires "Mode > Auto & Offset".
Adds an offset value to the attenuation value provided from the external frontend.

Remote command:
[ :SOURce<hw>] :EFRontend: POWer : OFFSet on page 61
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4.2.4 Cable correction settings

Access:
1. Select "RF" > "RF Frontend" > "Frontend Device".

2. Select "Cable Correction".

Settings  Versions / Options Attenuator Cable Correction Network LO Config

State
on

= Load Cable Correction File > Recommended Frequency Range ®
if_default_cable_1347_7552_00.s2p 3.620 GHz ... 9.620 GHz

Frequency Response
3 -
0.3 8

-0.6 &
-0.2 H H H H
12 H e e M
g :
£-15

5
G ;g W

5.05 5.5 5.95 6.4 6.85
Frequency (GHz)

The "Cable Correction" tab provides settings necessary to configure the frequency
response correction of the IF signal path.

You can load correction data to compensate for signal losses in the cable occurring at
different IF signal frequencies. Files containing correction data have the extension

* . s2p or * .uco. The following descriptions are exemplary with * . s2p files. Working
with * . uco files is analogous.

Settings:

S ALttt —————————————————aaaaaas 40
Load Cable CorreCtion File............oovieiiiiieiiiiiiciee e e e veve bbb 40
Recommended FrequenCy RanNgE.......cccoooiiiiiii e e e e e e e e e e e e e e e 41
State

Activates correction of the IF signal for different IF signal frequencies.

Activation requires loading of a valid cable correction file, see "Load Cable Correction
File" on page 40.

Remote command:
[ :SOURce<hw>] :EFRontend:ALIGnment [ : STATe] on page 55

Load Cable Correction File
Accesses a standard file-select dialog to load correction data to compensate for signal
losses in the cable occurring at different IF signal frequencies.

If a correction file is loaded, the button also displays the filename.
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You can load predefined cable correction files from frontend-specific folders. The pre-
defined cable correction files stored on the R&S SMM100A contain correction data for
the recommended standard R&S IF cable, using the S-parameter S21.

Table 4-3: Correction files and standard R&S IF cable for external frontends

External frontend R&S IF cable (order number) | Cable correction file

R&S FE44S 1347.7552.00 if default cable 1347 7552 00.s2p
R&S FE50DTR 1347.7552.00 if default cable 1347 7552 00.s2p
R&S FE110ST 1348.3850.00 if default cable 1348 3850 00.s2p
R&S FE170ST 1348.3850.00 if default cable 1348 3850 00.s2p

Example: Displaying file correction data

The example for the * . s2p file below comprises correction data for frequencies from
0 GHz to 7.5 GHz.

# HZ S DB R 50.00

! Date: 2020-06-12;11:48:28

! freq[Hz] db:S11 ang:S11 db:S21 ang:S21 db:S12 ang:S12 db:S22 ang:S5S22
100000.0 0.001 0 -0.018267469344920073 0 -0.018267469344920073 0 0.001 O
50000000.0 0.001 0 -0.10438567392872056 0 -0.10438567392872056 0 0.001 O
100000000.0 0.001 0 -0.1402532552881901 0 -0.1402532552881901 0 0.001 O

500000000.0 0.001 0 -0.37850173705964973 0 -0.37850173705964973 0 0.001 O
1000000000.0 0.001 0 -0.5387899823157998 0 -0.5387899823157998 0 0.001 O
2500000000.0 0.001 0 -0.8994010660064706 0 -0.8994010660064706 0 0.001 O
5000000000.0 0.001 0 -1.3888357992535698 0 -1.3888357992535698 0 0.001 O
7500000000.0 0.001 0 -1.8624967962088599 0 -1.8624967962088599 0 0.001 O

Frequency Response
o
-0.3

-0.6
-0.9
1.2 R
-1.5

Gain (dB)

-21
-2.4
-3

0 0375 075 1.125 1.5 1.876 225 2.625 3 3375 375 4125 45 4875 525 5.625 6 6.375 675 7.125 7.5
Frequency (GHz)

Remote command:
[ :SOURce<hw>] :EFRontend:ALIGnment:FILE:CATalog? on page 54
[ :SOURce<hw>] :EFRontend:ALIGnment:FILE[:SELect] on page 54

Recommended Frequency Range
Displays the recommended frequency range of the IF signal that the external frontend
requires.

We recommend that you cover this range in the cable correction file. See Example
"Displaying file correction data" on page 41.
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Remote command:

[ :SOURce<hw>] :EFRontend:ALIGnment : FILE: FREQuency:RANGe : LOWer?
on page 54

[ :SOURce<hw>] :EFRontend:ALIGnment :FILE: FREQuency:RANGe :UPPer?
on page 54

Network settings

Access:
1. Select "RF" > "RF Frontend" > "Frontend Device".

2. Select the "Network" tab.

Settings  Versions / Options Attenuator Cable Correction Network LO Config

Address Mode

Auto (DHCP)

IP Address @
192.168.0.1

Subnet Mask ®
255.255.255.0

v Apply

The tab provides settings to configure network settings of the external frontend.

Settings:

F o [0 [ (=Y AV, o Yo [ 42
|0 [0 [ f YT TN 42
SUDNEBE IMTASK.....cceeeeie et e et e e et e e e a e e e e e s e eaa s e saaeseebssenananas 43
o )OSR 43

Address Mode
Selects the mode for assigning the IP address of the external frontend.

"Auto (DHCP)" Assigns the IP address automatically, provided the network supports
DHCP (Dynamic Host Configuration Protocol).

"Static" Enables you to assign the IP address and subnet mask manually.
Remote command:

n.a.

IP Address

Displays the IP address of the external frontend in the network.
To assign an IP address manually, select "Address Mode" > "Static".

By default, the external frontend is configured to use dynamic TCP/IP configuration
and to obtain the whole address information automatically.

If the network does not support DHCP or the attempt does not succeed, the external
frontend tries to obtain the IP address via Zeroconf (APIPA) protocol. IP addresses
assigned via Zeroconf start with the number blocks 169.254.*.*.
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Note: An IP address that is assigned via the Zeroconf protocol although the network
requires an IP address assigned via the DHCP server can cause network connection
failures.

Remote command:
[ : SOURce<hw>] :EFRontend: IPADdress? on page 59

Subnet Mask
Displays the bit group of the subnet in the host identifier.

To assign the subnet mask manually, select "Address Mode" > "Static".

Remote command:
n.a.

Apply
Applies any changes to the network configuration of the external frontend.

If you change the network configuration, the connection is aborted and you must re-
establish a connection to the frontend.

See "To configure the R&S SMM100A for frontend control" on page 18.

Remote command:
[ :SOURce<hw>] :EFRontend:NETWork on page 60

4.2.6 External devices settings

External devices are available for the following external frontends:
e R&S FE170ST
® R&S FE110ST

Access:
1. Select "RF" > "RF Frontend" > "Frontend Device".

2. Select "External Devices".

Settings Versions / Options Attenuator Cable Correction Network | External Devices LO Config

{/', Refresh External Devices

External Device 1 External Device 2
Connected Device ©  Connected Device ®
FE170_Z50 FE170_Z01
Type © Type E
Amplifier Filter
Frequency Range 9 Frequency Range e
110.0 GHz ... 170.0 GHz 110.0 GHz ... 170.0 GHz
Gain e
10.0 dB
Additional External Device Correction
State off E E Load Correction File ,

The tab provides information about connected external devices.
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Refresh EXIErNal DEVICES. ........ci i ettt et e e e e e e e e e e e e 44
External Device 1/ EXtErnal DEVICE 2........coeeeeeeeeiieeeeeeee e e 44
L CONNECIE DEVICE. ..ottt e e ee e e e e e e eeeseeeeens 44
L 1Y/ =TSO 44
L FreqUENCY RANGE.......ceieeeeee ettt ettt ee s enns 44
L T 11 TR 44
Additional External Device CorreCtioN.........ouuuiiiiiiiiiee e 45
] 1= YU 45
L L0 COMMECHON FlE.. ettt ettt ettt eee e e eeeeeeeeeee 45

Refresh External Devices
Updates the display of external devices connected to the external frontend.

Remote command:
[ : SOURce<hw>] :EFRontend:EXTDevice:REFResh on page 62

External Device 1 / External Device 2
You can connect up to two external devices to the external frontend.

Connected Device < External Device 1 / External Device 2
Queries the name of the connected external device.

Remote command:
[ : SOURce<hw>] :EFRontend:EXTDevice<id>:NAME? on page 62

Type — External Device 1 / External Device 2
Queries the type of the connected external device.

FILTer A filter is connected to the frontend as an external device.
AMPLifier An amplifier is connected to the frontend as an external device.
ATTenuator An attenuator is connected to the frontend as an external device.
NONE No external device is connected to the frontend.

Remote command:
[ : SOURce<hw>] :EFRontend:EXTDevice<id>:TYPE? on page 63
[ :SOURce<hw>] :EFRontend:EXTDevice:LIST? on page 62

Frequency Range «— External Device 1 / External Device 2
Queries the minimum and maximum value of the frequency of the connected external
device.

Remote command:

[ :SOURce<hw>] :EFRontend:EXTDevice<id>:FREQuency:MINimum?
on page 63

[ :SOURce<hw>] :EFRontend:EXTDevice<id>:FREQuency:MAXimum?
on page 63

Gain — External Device 1 / External Device 2
Queries the gain of the amplifier connected as external device.

Remote command:
[ : SOURce<hw>] :EFRontend:EXTDevice<id>:GAIN? on page 63
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Additional External Device Correction

You can load user-defined correction files for the connected external devices, e.g. to
compensate for signal losses. Files containing correction data have the extension
*.s82p Or *.uco.

State — Additional External Device Correction
Activates correction of the RF signal for different RF signal frequencies for the connec-
ted external devices.

Activation requires loading of a valid correction file, see "Load Correction File"
on page 45.

Remote command:
[ : SOURce<hw>] :EFRontend:EXTDevice:CORRection:STATe on page 63

Load Correction File — Additional External Device Correction
Accesses a standard file-select dialog to load correction data, e.g. to compensate for
signal losses in the external device occurring at different RF signal frequencies.

If a correction file is loaded, the button also displays the filename.

Remote command:
[ : SOURce<hw>] :EFRontend:EXTDevice:CORRection:FILE on page 64

4.2.7 LO config settings

Access:
1. Select "RF" > "RF Frontend" > "Frontend Device".

2. Select "LO Config".

Settings  Versions / Options Attenuator Cable Correction Network External Devices LO Config

Mode v Mandatory LO IN Frequency ©
External 8 812.500 000 00 MHz

Out State . LO OUT Frequency e
On 8 812.500 000 00 MHz

The tab provides settings for configuring the local oscillator when using more than
one external frontend in a test setup.

Settings:

[ To L= TP USSP TP PPP P 45
(O 1) B 1= (= TP TR PP 46
Mandatory LO IN FreQUENCY ........uuiiiiiiiieie ettt e 46
O O LU I o = To U 1T o o PRSP 46
Mode

Selects the LO input source for the connected external frontend.

INTernal Uses the internally generated LO signal.

EXTernal Uses an externally supplied LO signal.
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Remote command:
[ : SOURce<hw>] :EFRontend:L0SCillator :MODE on page 64

Out State
Activates or deactivates the LO output of the connected external frontend.

Remote command:
[ : SOURce<hw>] :EFRontend:L0SCillator:0UTPut: STATe on page 64

Mandatory LO IN Frequency
Requires "Mode > External".

Displays the required frequency on the "LO In" connector of the connected external
frontend.

Set the displayed frequency value for the externally supplied LO signal correctly on the
external frequency source.

Remote command:
[ :SOURce<hw>] :EFRontend:LOSCillator:INPut:FREQuency? on page 64

LO OUT Frequency
Requires "Out State > On".

Displays the current frequency on the "LO Out" connector of the connected external
frontend.

Remote command:
[ :SOURce<hw>] :EFRontend:L0SCillator:0UTPut: FREQuency? on page 65
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Troubleshooting Frontend Control

If problems arise during external frontend control, try the following measures to opti-
mize the connection.

Resolving network connection errors

If you cannot connect to the external frontend, check the status bar or error queue of
the R&S SMM100A for error messages. See Table 5-1

If no messages are available, check the "LAN" and "Power" status LEDs on the exter-
nal frontend. Permanent red lights indicate an error, usually hardware problems, e.qg. if
the fans are off. In this case, the instrument is automatically put in a safe (error) state
to avoid damage. A LAN connection is no longer possible. Try switching the external
frontend off and on again.

Handling touchstone file errors

Some errors concerning . s2p correction files do not cause warnings in the status bar.
Also, they do not provide results in the system error queue, but do display messages
or return errors in remote control.

Error messages

If errors occur, status messages in the external frontend configuration dialog box and in
the status bar of the display inform you about them.

Query the error message queue using the remote command SYST: ERR? to determine
if any or which errors occurred during operation.

For details, see chapter "Troubleshooting and Error Messages" in the R&S SMM100A
user manual.

If any errors occur that are not described here, contact the Rohde & Schwarz customer
support.

Table 5-1: Status and error messages

Connected

Status bar message Dialog status SYST:ERR? result Description/Remedy
External Frontend [x]: Connecting... Connection to the external frontend is being estab-
Connecting... lished.
It can take up to 10 seconds to determine that LAN
connection failed.
Connected Connected Connection established, ready for operation.
No External Frontend Not connected No external frontend detected.

Connect an external frontend to the
R&S SMM100A.

External Frontend [x]:
Invalid Host IP

Invalid Host IP 300, "Invalid Host Verify the specified IP address of the external fron-
ip" tend.
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Status bar message

Dialog status

SYST:ERR? result

Description/Remedy

External Frontend [Xx]:
LAN Connection Failed

Not connected

301, "LAN Connection
Failed"

Verify if the external frontend is connected to the
same network as the R&S SMM100A.

Verify the specified IP address of the external fron-
tend.

Make sure that no other instrument is accessing
the external frontend at the moment.

External Frontend [x]:
Incompatible Signal
Generator Firmware

Incompatible Signal
Generator Firmware

302, "Incompatible
Signal Generator
Firmware"

The frontend hardware is not compatible with the
installed signal generator firmware.

Update the signal generator firmware, see the
R&S SMM100A service manual.

External Frontend [x]:
Incompatible Frontend
Firmware

Incompatible Fron-
tend Firmware

303, "Incompatible
Frontend Firmware"

The firmware of the external frontend is not up to
date.

Perform a firmware update of the external frontend.

Firmware Update Failed

Failed

Update Failed"

External Frontend [x]: Device Locked 304, "Device Locked" | The external frontend is accessible via ping, but no
Device Locked SSL-connection could be established.
Disconnect all other devices that are currently
accessing the external frontend and try reconnect-
ing.
External Frontend [Xx]: Wrong Device Type 306, "Wrong Device The connected external frontend is not of the
Wrong Device Type Type" specified type.
Disconnect the device, select the correct external
frontend type in the configuration dialog box, and
reconnect.
External Frontend [x]: LAN Connection Lost | 314, "LAN Connection | The connection to the external frontend has been
LAN Connection Lost Lost™" lost.
The signal generator attempts to reconnect periodi-
cally. Wait for the "Connecting..." message.
External Frontend [X]: Firmware Update 315, "Firmware The firmware of the external frontend was not

updated successfully.

<filename>.s2p has -150, "String data The . s2p file does not have the correct syntax.
H "
wrong file format error Correct the file.
-256, "File name not | The specified . s2p file does not exist.
f a” )
oun Correct the path and filename and make sure that
the file is stored on the instrument
under /var/user//external frontends/
<frontend type>/touchstonefiles.
External Frontend [x]: 350, "Touchstone The . s2p file does not cover the used frequency.
ile i i- file £ ) . . )
T_ouchstone file insuffi e %eguenfy FANIE | Correct the file or select a different correction file.
cient frequency range insufficient

If you still have connection problems, contact Rohde & Schwarz, see chapter "Contact-
ing Customer Support" in the R&S SMM100A user manual.
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®

6.1

SOURCce:EFRontend subsystem

Remote control commands

The following commands are required to generate signals with the Frontend Control
option in a remote environment. We assume that the R&S SMM100A has already been
set up for remote operation in a network as described in the R&S SMM100A documen-
tation. A knowledge about the remote control operation and the SCPI command syntax
is assumed.

Conventions used in SCPl command descriptions

For a description of the conventions used in the remote command descriptions, see
section "Remote-Control Commands" in the R&S SMM100A user manual.

Common suffixes

The following common suffixes are used in the remote commands:

Suffix Value range Description

SOURce<hw> 1 Available baseband signals
OUTPut<ch> 1t03 Available markers
CALibration<hw> |[1] Optional suffix

Programming examples

This section provides simple programming examples. The purpose of the examples is
to present all commands for a given task. In real applications, you typically use an
appropriate subset of these commands.

For verification and testing purposes, a software tool executed these programming
examples. To keep the example as simple as possible, the examples report clean SCPI
syntax elements. Non-executable command lines, for example comments, start with
two characters / /.

Before executing a SCPI sequence, most remote control programs reset or preset the
instrument to a definite state. The commands *RST and SYSTem: PRESet are equiva-
lent for this purpose. *CLS also resets the status registers and clears the output buffer.

The following chapters describe the commands specific to the Frontend Control option.

e SOURce:EFRoNtend SUDSYSIEM........ocoviiiiiiiiiiccccrie e 49
o CALIbration SUDSYSIEM........ccoi i e ——————— 65

SOURce:EFRontend subsystem

The SOURce : EFRontend subsystem contains the commands for configuring settings
of an RF frontend.
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SOURCce:EFRontend subsystem

Example: Configuring external frontend connection settings

// Query information about the connected RF frontend.

SOURcel:EFRontend: INFO?

// Response: <SymbolicName> "FE170ST-123456", <RemoteChannel> "Frontend Connection"
// <IpAddress>/<HostName> "FE170ST-123456",<ConnectionState> "connected"

// Query all connected external frontends, including equipped options:
SOURcel:EFRontend:LIST?

// Response: "FE170ST-123456"

SOURcel:EFRontend: IDN?

// Response: "Rohde&Schwarz,FE170ST,1234.5678K00/123456,1.34.6"

// Specify and query frontend connection settings.
SOURcel :EFRontend:RFConnector?

// Response: "RFA"

SOURcel :EFRontend:CMODe?

// Response: "AUTO"
SOURcel:EFRontend:FREQuency:REFerence:LIST?

// Response: "10 MHz, 640 MHz,1 GHz"
SOURcel:EFRontend:FREQuency:REFerence F1G

// Sets 1 GHz reference frequency.

//Example: Query of RF connector with connected R&S FE50DTR
SOURcel:EFRontend:RFConnector?
// Response: "RFB"

Example: Configuring external frontend frequency bands

// Load a frequency band configuration.

SOURcel :EFRontend: FREQuency:BAND1 :CONFig:CATalog?

// Response: "IF Low,IF High"

SOURcel :EFRontend: FREQuency:BAND1:CONFig:SELect "IF Low"

// Query the corresponding intermediate frequency at the RF output of the R&S SMM100A.
SOURcel:EFRontend: IFRequency?

// Response in Hz: "3900000000"™ (= 3.9 GHz)

// Query information about operating frequency bands.
SOURcel :EFRontend: FREQuency : BAND: COUNt ?

// Response: "2"

// The frontend operates in two frequency bands.

// Query ranges of the operating frequency bands.
SOURcel:EFRontend: FREQuency:BAND1 : LOWer?

// Response in Hz: "24240000000" (= 24.24 GHz)
SOURcel :EFRontend: FREQuency :BAND1 :UPPer?

// Response in Hz: "33400000000" (= 33.4 GHz)
SOURcel :EFRontend: FREQuency :BAND2 : LOWer?

// Response in Hz: "37000000000"™ (= 37 GHz)
SOURcel :EFRontend:FREQuency:BAND2 : UPPer?

// Response in Hz: "43500000000" (= 43.5 GHz)
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Example: Configuring LO settings with multiple external frontends

// B R o o R
// Example test setup: 2x R&S FE44S

// R R R IRk I I b S h h b b b dE b b dh b E b b b b h b b b b b b b b E I b b h E E h b b b dE b b b b b b b b h b b b b b b b b b b b bk b b b b b
// Set R&S FE44S (connected to the vector signal generator)

// To receive the LO signal

SOURcel:EFRontend:LOSCillator:MODE EXTernal

SOURcel :EFRontend:LOSCillator:0UTPut:STATe 0

// Query the LO out frequency

SOURcel:EFRontend:LOSCillator:INPut:FREQuency?

// Response in Hz: "9937500000"

// Check the frequency band configuration

SOURcel :EFRontend: FREQuency :BAND:CONFig:MODE?

// Response: "AUTO"

SOURcel :EFRontend: FREQuency:BAND:CONFig:SELect?

// Response: "IF Low"

VAR EEEEEE R AR R EEE e AR EE e AR EEE LR R R R Rt

// Example test setup: R&S FE170ST and R&S FE170SR

// ER R IR I I I I b h b b b b b b b dh b b b b b b b b b b h b b b I b b h E E b b b b b b b b h b b b b h E b b b h b b b b b b b b b b b b b
// Set R&S FE170ST to provide the LO signal
SOURcel:EFRontend:LOSCillator:MODE INTernal
SOURcel:EFRontend:LOSCillator:0UTPut:STATe 1

// Query the LO out frequency
SOURcel:EFRontend:LOSCillator:0OUTPut:FREQuency?

// Response in Hz: "14988281250"

// Set the frequency band configuration

// To use the same frequency band according to a frequency plan
SOURcel :EFRontend: FREQuency:BAND:CONFig:MODE MANual

SOURcel :EFRontend:FREQuency:BAND:CONFig:SELect "Shared LO"

Example: Configuring external frontend attenuation

// Configure attenuation settings.
SOURcel :EFRontend:AMODe?

// Response: "AUTO"
SOURcel:EFRontend:AMODe MANual

SOURcel :EFRontend: POWer:ATTenuation 10
// Sets an attenuation of 10 dB.
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Example: Configuring external frontend cable correction

// Query available cable correction files.
SOURcel:EFRontend:ALIGnment:FILE:CATalog?

// Response: "CableCorrIF"

// Add cable correction data by loading the file CableCorrIF.s2p.
SOURcel:EFRontend:ALIGnment:FILE:SELect CableCorrIF

// Query upper and lower frequency range of the IF correction data.
SOURcel:EFRontend:ALIGnment :FILE: FREquency :RANGe: LOWer?

// Response in Hz: "4500000000" (4.5 GHz)
SOURcel:EFRontend:ALIGnment:FILE:FREquency:RANGe:UPPer?

// Response in Hz: "6820000000"™ (6.82 GHz)
SOURcel:EFRontend:ALIGnment:STATe 1

Example: Calibrating external frontends

// Start a calibration procedure performing internal adjustments
// at the external frontend.

SOURcel:EFRontend:CAL:ALL

// Query the calibration state.
CALibrationl:FREQuency:CONVerter:EXTernal?

// Response: "1"

// The external frontend is calibrated.

Example: Configuring external frontend network parameters

// Search for your external frontend in the network.

SOURcel:EFRontend: INFO?

// Response: <SymbolicName> "FE170ST-123456", <RemoteChannel> "Frontend Connection"
// <IpAddress>/<HostName> "10.123.45.67",<ConnectionState> "not connected"
SOURcel:EFRontend:NETWork?

// Response: <IpAddress> "10.123.45.67",<SubnetMask> "255.255.255.0",<DhcpOn> "1"
// Alternatively, query the IP address directly.

SOURcel:EFRontend: IPADdress?

// Response: "10.123.45.67"

// Switch off DHCP and assign an IP address manually.

SOURcel:EFRontend:NETWork "192.168.0.1","255.255.255.0","0"
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Example: Querying external devices connected to an external frontend

// Refresh the connected external devices.
SOURcel:EFRontend:EXTDevice:REFResh

// Query a list of connected external devices:

SOURcel :EFRontend:EXTDevice:LIST?

// Response:"FE170 z50,FE170 z01"

// Query the information regarding External Device 1:

// Query the name of the connected external device:
SOURcel:EFRontend:EXTDevicel :NAME?

// Response: "FE170 750"

//Query the type of the connected external device:
SOURcel:EFRontend:EXTDevicel :TYPE?

// Response: AMPL

// Query the frequency range of the connected external device:
SOURcel :EFRontend:EXTDevicel :FREQuency:MINimum?

// Response: 110000000000
SOURcel:EFRontend:EXTDevicel : FREQuency:MAXimum?

// Response: 170000000000

// Since the connected external device is an amplifier, query the gain:
SOURcel :EFRontend:EXTDevicel : GAIN?

// Response: 10

Commands:

[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:LOWer?..........ccceeeueeennnen 54
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:UPPer?.......cc.cccceeeneeennnnn 54
[:SOURce<hw>]:EFRontend:ALIGNMeNt:FILE:CATalOg?......ceuiiiiieeeiiee e 54
[:SOURce<hw>]:EFRontend:ALIGNmMent:FILE[:SELECH].......ccvuiiiimiireeii e 54
[:SOURce<hw>]:EFRontend:ALIGNMEN[:STATE].....ceutuiieiiitiniee ettt et eees 55
[:SOURCce<hw>]:EFRONENA:AMODE. .....cuuuieieieeiiiie e e ettt ee e e e et e e e e e e et e e e e e eena s e e e eeernnanss 55
[:SOURCe<hW>]:EFRONENA:CALIALL.....iiiiiiiiiieeeeeeeeeee e eeeetee e e e et e e e e e eeabe e e e e e eebanaeeaes 55
[:SOURce<hw>]:EFRoNtend:CONNECHON:STATE. ....ccuvuieeeieiririeeeeeieeriieeeeeeerstaeeeeseesnnaaeeaeens 55
[:SOURce<hw>]:EFRONENA:CMODE.... ...ttt e e e e e e eeas 56
[:SOURce<hw>]:EFRontend:FREQuency:BAND:COUNL?........ocevmiiiiriiiieeeeeee e 56
[:SOURce<hw>]:EFRontend:FREQuency:BAND:CONFig:CATalog?.......ccvuruuirerieriiininreeeeennnns 57
[:SOURce<hw>]:EFRontend:FREQuency:BAND:CONFig:MODE.............cccvvrrrreevrrrnrnnnnnnnnnnns 57
[:SOURce<hw>]:EFRontend:FREQuency:BAND:CONFig:SELECt.........ceieerruiiirieriiiiinienceennans 57
[:SOURce<hw>]:EFRontend:FREQuUency:BAND<Ch>:LOWEI?.......ccceurueierererinnineeeereeininenaaens 58
[:SOURce<hw>]:EFRontend:FREQuency:BAND<Ch>:UPPEI?.........ccccuueierireeiniianeeereninianeeanns 58
[:SOURce<hw>]:EFRontend:FREQuency:REFerence...........cocoiiiiiiiiiiiiiiiiceeeee 58
[:SOURce<hw>]:EFRontend:FREQuency:REFerence:LIST?....cc..ovieeiiiiiiiieeieeeeeeeee e 58
[:SOURCe<hwW>]:EFRONIENA:IDN?......cieee e e e e eee ettt s s e e e e e e e e e e e e e aeeeeeeeeeeneenees 58
[:SOURce<hw>]:EFRontend[:FREQuency]:IFRequency[:VALUE]?........c.ccceeeiirirreireiiieeeeeieeen, 59
[:SOURce<hw>]:EFRontend:FREQuency:IFRequency:SIDeband?...........ccoeeuirieeniiiiennnennnnn. 59
[:SOURCe<hW>]:EFRONENA:INFO?.....ccviiiiiieeeietiee et e et e e et e e e e e e eate e e e s eeeaananns 59
[:SOURCce<hw>]:EFRONtENA:IPADAIESS?...cevuruieieeiieiieieeeeeeitae e e e s eeeie s e e e eeeanneseeeeeeraneeeeenenes 59
[:SOURCe<hW>:EFRONIENA: LIS T 2. . et e e e e e e e e eas 60
[:SOURce<hw>]:EFRONENA:INETWOIK....cceeeeeeeeeeeeeeieeeeeeeeeeeietieieeeeaseae e e e e e e e e e e e e aeeeeeeeeeneeees 60
[:SOURCE<hW>]:EFRONIENA:OPT 2. i cieeeeeeeeeeeeeeetietesese s s e e e e e e e e e e e e eaeeeeeeeeeeeeeeeeenennnnnnnnnns 60
[:SOURce<hw>]:EFRontend:POWer:ATTENUALION........ceeeieiiiiieeeeeeeticeeeee e et e e e e e e eenae e eeeees 61
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[:SOURce<hw>]:EFRoNtend:POWEIrOFFSet.......ccuuuiiiiieiiiiiie e et e e e e e eeeea 61
[:SOURce<hw>]:EFRONtENd:RFCONNECION.....ccuuuiieeeieiiie e e eeeeeies e e e e e e e e e e e e e e eeaaae e e e 61
[:SOURce<hw>]:EFRontend:EXTDeVIiCe:REFRESH. .......uuiiiaieieiee e 62
[:SOURce<hw>]:EFRoNteNd:EXTDEVICELIST2.cceveiiiieruiaaaaaaeieeeeeeeeeeeeeeeeeeeeeeeeeeenennnnnnenens 62
[:SOURce<hw>]:EFRontend:EXTDeVice<id>:NAME?..........cccvrieirieieeeeinienncceseese e e e e e aaaaaaas 62
[:SOURce<hw>]:EFRontend:EXTDEVICE<IA>TYPE?.....ciiiiiierieeeeeeeeetieeeeeeerre e e e e e ersaneeeaeens 63
[:SOURce<hw>]:EFRontend:EXTDevice<id>:FREQuency:MINimum?........c...cccoeiiiiiniiniiennnns 63
[:SOURce<hw>]:EFRontend:EXTDevice<id>:FREQuency:MAXIimUM?.........ccuceeererrernnnrenennns 63
[:SOURce<hw>]:EFRontend:EXTDeVIce<id>:GAIN?.......cccuiieieerieiiie e e eeeeiee e e e e e e e eeennaes 63
[:SOURce<hw>]:EFRontend:EXTDevice:CORRECtION:STATE. ....ucciieieieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeees 63
[:SOURce<hw>]:EFRontend:EXTDevice:CORRECHON:FILE........cccvvvieeieeeeeeieeciniieeeeeeeeeenn, 64
[:SOURce<hw>]:EFRontend:LOSCillator:MODE...........ccuuueieeeeieiiiieiee et eeeeerte e e e e eerananss 64
[:SOURce<hw>]:EFRontend:LOSCillator:QUTPUL:STATE. ... iiii it 64
[:SOURce<hw>]:EFRontend:LOSCillator:INPut:FREQUENCY?......uuueeieerieiiieeeeeeeenaeeeeeeeenanns 64
[:SOURce<hw>]:EFRontend:LOSCillator:OUTPuUt:FREQUENCY?.......oeiuiiiiiiiiieiieee e 65

[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:LOWer?
[:SOURce<hw>]:EFRontend:ALIGnment:FILE:FREQuency:RANGe:UPPer?

Queries the upper/lower frequency range of IF values required at the connected exter-
nal frontend.

We recommend that you cover this range in the cable correction file.

Return values:
<CableCorrFreqUp> float

Example: See Example "Configuring external frontend cable correction”
on page 52.
Usage: Query only

Manual operation: See "Recommended Frequency Range" on page 41

[:SOURce<hw>]:EFRontend:ALIGnment:FILE:CATalog?
Queries the cable correction files with settings in the default directory.

Listed are cable correction files with extension * . s2p or *.uco.

Example: See Example "Configuring external frontend cable correction"
on page 52.
Usage: Query only

Manual operation: See "Load Cable Correction File" on page 40

[:SOURce<hw>]:EFRontend:ALIGnment:FILE[:SELect] <CableCorrFileNa>

Selects an existing correction file to compensate for cable losses. Selectable files have
file extension * . s2p or * .uco.

Parameters:
<Filename> string
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Example: See Example "Configuring external frontend cable correction”
on page 52.

Manual operation: See "Load Cable Correction File" on page 40

[:SOURce<hw>]:EFRontend:ALIGnment[:STATe] <CableCorrState>

Activates correction of the IF signal for different IF signal frequencies.

Parameters:

<CableCorrState> 1|ON |0 | OFF
*RST: 0

Example: See Example "Configuring external frontend cable correction”
on page 52.

Manual operation: See "State" on page 40

[:SOURce<hw>]:EFRontend:AMODe <AttenuationMode>

Sets the attenuator mode of the external frontend.

Parameters:
<AttenuationMode> AUTO | MANual | AOFFset
AUTO
Sets the attenuation value automatically to the attenuation value
provided from the connected external frontend.
MANual
Sets an attenuation value manually.
AOFFset
Requires frontend R&S FE170ST or R&S FE110ST.
You can define an offset value which is added to the attenuation
value provided from the connected external frontend.
*RST: AUTO
Example: See Example "Configuring external frontend attenuation”
on page 51.

Manual operation: See "Mode" on page 39

[:SOURce<hw>]:EFRontend:CAL:ALL
Starts all internal calibration routines to adjust the connected external frontend.
Example: See Example "Calibrating external frontends" on page 52

Usage: Event

[:SOURce<hw>]:EFRontend:CONNection:STATe <ConnState>

Queries the state of the connection between R&S SMM100A and external frontend.
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Parameters:
<ConnState> 1]ON|0|OFF
*RST: 0
Example: See Example "Configuring external frontend connection set-

tings" on page 50.

Manual operation: See "Remote connection status" on page 32

[:SOURce<hw>]:EFRontend:CMODe <FeConnMode>

Sets the mode of the SSL control connection between R&S SMM100A and external
frontend.

Parameters:
<FeConnMode> AUTO | LOCK | RXTX

AUTO

The R&S SMM100A locks external frontend, when activating the
RF output at the R&S SMM100A (: 0OUTPutl ON ) for output of
the IF signal.

The R&S SMM100A unlocks external frontend, when deactivat-
ing the RF output at the R&S SMM100A (: OUTPutl OFF).

LOCK
The external frontend is locked permanently. No other instru-
ment can take over control.

RXTX

Requires an R&S FES50DTR connected to the R&S SMM100A.
Connection mode for simultaneous Rx (receive) operation and
Tx (transmit) operation of an R&S FE50DTR.

Set this mode, if your test setup requires a release of connection
lock. A connected vector signal analyzer can lock the external
frontend for Rx operation.

Example: See Example "Configuring external frontend connection set-
tings" on page 50

Manual operation: See "Connection Mode" on page 34

[:SOURce<hw>]:EFRontend:FREQuency:BAND:COUNt?
Queries the number of frequency bands available at the connected external frontend.

Return values:

<FEFreqCount> integer

Example: See Example "Configuring external frontend frequency bands"
on page 50

Usage: Query only

Manual operation: See "Frequency Band x" on page 37
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[:SOURce<hw>]:EFRontend:FREQuency:BAND:CONFig:CATalog? <CatalogFiles>

Queries the selectable frequency band configuration modes.

Parameters:

<CatalogFiles> string
Returns a string of selectable frequency band configuration
modes separated by commas.

Example: See Example "Configuring external frontend frequency bands"
on page 50

Usage: Query only

Manual operation: See "Frequency Band Config" on page 35

[:SOURce<hw>]:EFRontend:FREQuency:BAND:CONFig:MODE <Mode>
Sets the mode for frequency band configuration of the external frontend.
Parameters:

<Mode> AUTO | MANual

AUTO

Configures the frequency band automatically.

R&S FE44S and R&S FE50DTR: For bandwidths < 400 MHz,
"IF Low" is used. For bandwidths larger than 400 MHz, "IF High"
is used.

R&S FE170ST or R&S FE110ST: "Spur Optimized" is used.

MANual

Uses the frequency band configured by [ : SOURce<hw>] :
EFRontend:FREQuency:BAND:CONFig:SELect

on page 57.

*RST: AUTO

Manual operation: See "Mode" on page 35

[:SOURce<hw>]:EFRontend:FREQuency:BAND:CONFig:SELect <SelBandConfig>
Selects the frequency band configuration for the connected external frontend.
Enter the mode as string, e.g. "IF Low".

Parameters:
<SelBandConfig> string

Example: See Example "Configuring external frontend frequency bands"
on page 50

Manual operation: See "Frequency Band Config" on page 35
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[:SOURce<hw>]:EFRontend:FREQuency:BAND<ch>:LOWer?
[:SOURce<hw>]:EFRontend:FREQuency:BAND<ch>:UPPer?

Queries the lower/upper limit of the corresponding frequency band.

Return values:
<FEFregBandUp> float

Example: See Example "Configuring external frontend frequency bands"
on page 50
Usage: Query only

Manual operation: See "Frequency Band x" on page 37

[:SOURce<hw>]:EFRontend:FREQuency:REFerence <FERefFreq>

Sets the reference frequency, that is used for RF frequency conversion at the connec-
ted external frontend.

Parameters:
<FERefFreqg> FG64 | F1G | F10M

FG64
640 MHz

F1G
1 GHz

F10M
10 MHz

Example: See Example "Configuring external frontend connection set-
tings" on page 50.

Manual operation: See "Reference Frequency" on page 34

[:SOURce<hw>]:EFRontend:FREQuency:REFerence:LIST?
Queries reference frequencies of connected RF frontends in a comma-separated list.

Example: See Example "Configuring external frontend connection set-
tings" on page 50.

Usage: Query only

Manual operation: See "Reference Frequency" on page 34

[:SOURce<hw>]:EFRontend:IDN?
Identification
Returns the IDN string, i.e. the identification of the external frontend.

Return values:
<ldnString> string
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Example: See Example "Configuring external frontend connection set-
tings" on page 50.

Usage: Query only

Manual operation: See "Hardware Config" on page 38

[:SOURce<hw>]:EFRontend[:FREQuency]:IFRequency[:VALue]?
Queries the frequency of the IF signal, that is the frequency at the RF connector.

Return values:

<IntFrequency> float

Example: See Example "Configuring external frontend frequency bands"
on page 50.

Usage: Query only

Manual operation: See "Intermediate Frequency / Sideband" on page 35

[:SOURce<hw>]:EFRontend:FREQuency:IFRequency:SIDeband?
Queries the currently used sideband for frequency conversion.

Return values:
<Sideband> string

usB
Upper sideband

LSB
Lower sideband

Usage: Query only

Manual operation: See "Intermediate Frequency / Sideband" on page 35

[:SOURce<hw>]:EFRontend:INFO?
Queries information about the connected external frontend.

Return values:
<FElInfo> string

Example: See Example "Configuring external frontend connection set-
tings" on page 50.

Usage: Query only

[:SOURce<hw>]:EFRontend:IPADdress?
Queries the IP address of the connected external frontend.

Return values:
<IPAddress> string
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Example: See Example "Configuring external frontend network parame-
ters" on page 52.

Usage: Query only

Manual operation: See "IP Address" on page 42

[:SOURce<hw>]:EFRontend:LIST?
Queries connected external frontends in a comma-separated list.

Return values:
<Filter> String

Example: See Example "Configuring external frontend connection set-
tings" on page 50.

Usage: Query only

[:SOURce<hw>]:EFRontend:NETWork <IpAddress>, <SubnetMask>, <DhcpOn>

Sets network parameters of the external frontend.

Parameters:
<IpAddress> string
IP address of the external frontend
*RST: 127.0.0.1
<SubnetMask> string
Bit group of the subnet in the host identifier
*RST: 255.255.255.0
<DhcpOn> integer
DHCP state
Range: 0 to 1
*RST: 1
Example: See Example "Configuring external frontend network parame-

ters" on page 52.

Manual operation: See "Apply" on page 43

[:SOURce<hw>]:EFRontend:OPT?
Option identification query
Queries the options included in the external frontend.

For more information, refer to the specifications document.
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Return values:
<OptString> string

The query returns a list of options. The options are returned at
fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

Manual operation: See "Hardware Config" on page 38

[:SOURce<hw>]:EFRontend:POWer:ATTenuation <Attenuation>
Requires [SOURce<hw>] :EFRontend:AMODe MANual.

Sets the attenuation of the external frontend.

Parameters:
<Attenuation> float
Range: depends on connected device to depends on con-
nected device
Increment: depends on connected device
*RST: 0
Example: Example "Configuring external frontend attenuation" on page 51

Manual operation: See "Attenuation" on page 39

[:SOURce<hw>]:EFRontend:POWer:OFFSet <Offset>

Requires frontend R&S FE170ST or R&S FE110ST.

Requires [SOURce<hw>] :EFRontend:AMODe AOFFset.

Adds an offset value to the attenuation value provided from the external frontend.

Parameters:
<Offset> float

Range: depends on connected device to depends on con-
nected device

Increment: depends on connected device

*RST: 0

Manual operation: See "Offset" on page 39

[:SOURce<hw>]:EFRontend:RFConnector <FEOutpPath>
Queries the active RF output connector at the connected RF frontend.

Parameters:
<FEOutpPath> NONE | RFA | RFB

NONE
No frontend connected.
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RFA
Output connector "RF A" is active at the external frontend.

RFB
Output connector "RF B" is active at the external frontend.

Example: See Example "Configuring external frontend connection set-
tings" on page 50.

Manual operation: See "Active RF Connector" on page 35

[:SOURce<hw>]:EFRontend:EXTDevice:REFResh
Updates the external devices connected to the external frontend.

Use this command before the query
[ :SOURce<hw>] :EFRontend:EXTDevice:LIST?.

Example: See Example "Querying external devices connected to an exter-
nal frontend" on page 53.

Usage: Event

Manual operation: See "Refresh External Devices" on page 44

[:SOURce<hw>]:EFRontend:EXTDevice:LIST?

Queries the external devices connected to the external frontend in a comma-separated

list.

Example: See Example "Querying external devices connected to an exter-
nal frontend" on page 53.

Usage: Query only

Manual operation: See "Type" on page 44

[:SOURce<hw>]:EFRontend:EXTDevice<id>:NAME?
Queries the name of the connected external device.

Return values:
<DeviceName> string

Example: See Example "Querying external devices connected to an exter-
nal frontend" on page 53.

Usage: Query only

Manual operation: See "Connected Device" on page 44
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[:SOURce<hw>]:EFRontend:EXTDevice<id>:TYPE?
Queries the type of the connected external device.

Return values:
<Type> FILTer | AMPLifier | AT Tenuator | NONE

FiLTer
A filter is connected to the frontend as external device.

AMPLifier
An amplifier is connected to the frontend as external device.

ATTenuator
An attenuator is connected to the frontend as external device.

NONE
No external device is connected to the frontend.

Example: See Example "Querying external devices connected to an exter-
nal frontend" on page 53.

Usage: Query only

Manual operation: See "Type" on page 44

[:SOURce<hw>]:EFRontend:EXTDevice<id>:FREQuency:MINimum?
[:SOURce<hw>]:EFRontend:EXTDevice<id>:FREQuency:MAXimum?

Queries the maximum value of the frequency of the connected external device.

Example: See Example "Querying external devices connected to an exter-
nal frontend" on page 53.

Usage: Query only

Manual operation: See "Frequency Range" on page 44

[:SOURce<hw>]:EFRontend:EXTDevice<id>:GAIN?
Queries the gain of the amplifier connected as external device.

Return values:

<Gain> float
*RST: n.a. (factory preset)
Example: See Example "Querying external devices connected to an exter-

nal frontend" on page 53.
Usage: Query only

Manual operation: See "Gain" on page 44

[:SOURce<hw>]:EFRontend:EXTDevice:CORRection:STATe <State>

Activates correction of the RF signal for different RF signal frequencies.
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Activation requires loading of a valid correction file.

Parameters:
<State> 1]ON| 0| OFF

*RST: 0

Manual operation: See "State" on page 45

[:SOURce<hw>]:EFRontend:EXTDevice:CORRection:FILE <Filename>

Selects an existing correction file, e.g. to compensate for cable losses. Selectable files
have file extension *.s2p or *.uco.

Parameters:
<Filename> string

Manual operation: See "Load Correction File" on page 45

[:SOURce<hw>]:EFRontend:LOSCillator:MODE <Mode>
Selects the LO input source for the connected external frontend.

Parameters:
<Mode> INTernal | EXTernal

INTernal
Uses the internally generated LO signal.

EXTernal
Uses an externally supplied LO signal.

*RST: n.a. (factory preset: INTernal)

Example: See Example "Configuring LO settings with multiple external
frontends" on page 51.

Manual operation: See "Mode" on page 45

[:SOURce<hw>]:EFRontend:LOSCillator:OUTPut:STATe <OutState>

Activates or deactivates the LO output of the connected external frontend.

Parameters:
<OutState> 1] ON |0 | OFF
*RST: n.a. (factory preset: 0)
Example: See Example "Configuring LO settings with multiple external

frontends" on page 51.

Manual operation: See "Out State" on page 46

[:SOURce<hw>]:EFRontend:LOSCillator:INPut:FREQuency?

Requires [ :SOURce<hw>] :EFRontend:L0OSCillator:MODE EXTernal.
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Queries the required frequency on the "LO In" connector of the connected external
frontend.

Return values:
<LolnFreqg> float

Example: See Example "Configuring LO settings with multiple external
frontends" on page 51.

Usage: Query only

Manual operation: See "Mandatory LO IN Frequency" on page 46

[:SOURce<hw>]:EFRontend:LOSCillator:OUTPut:FREQuency?
Requires [ :SOURce<hw>] :EFRontend:LOSCillator:0UTPut:STATe 1.

Queries the current frequency on the "LO Out" connector of the connected external
frontend.

Return values:
<OutputFrequency> float

Example: See Example "Configuring LO settings with multiple external
frontends" on page 51.

Usage: Query only
Manual operation: See "LO OUT Frequency" on page 46

6.2 CALibration subsystem

The CALibration subsystem contains the commands for calibration of an RF fron-
tend.

Commands:

:CALibration<hw>:FREQuency:CONVerter:EXTernal?
Queries the calibration state of the connected external instrument.
External instrument can be for example an external frontend.

Return values:

<Success> 1|ON |0 | OFF
*RST: 0

Exarnple: // Query calibration state of a connected external frontend.
CAL1:FREQ:CONV:EXT?
// 1

// The external frontend connected in path A is calibrated.

Usage: Query only
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